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Section 1: Getting Started
This “Quick Start Guide” is designed as an initial getting started guide to the Farmplan Cash
Manager program to help you through the first stages of using the program. Please take
time to look through our Demonstration Data and plan your own set up carefully so that you
get the most out of the program and your own information.

For more detailed instruction we have a number of other solutions to help you get the most
out of the program.

Training
There is no substitute for personalised one-to-one training. We have a number of Farmplan
trainers around the country and we can arrange for someone, who is local to you, to visit
you for a half or full day at your business. We would recommend that two half day sessions
are always more effective than one whole day as learning a new computer program takes a
lot of concentration. The ideal solution is one half day session to plan the initial setup and
to get you going, followed up with another half day a few weeks later to answer your
questions.

If you would prefer you can come to our offices in Ross on Wye, Herefordshire or we can
‘log’ onto your computer remotely and talk you through the training via the phone.

Help Notes
Every screen within the program has a ‘Help’ button at the bottom.

Clicking on this button will take you to detailed instructions of
exactly what you should be entering on this screen. For a more
detailed view of the whole Help text go to the menu option Help Contents.
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Farmplan Support Line – 01594 545022
We have a dedicated customer support line available on 01594 545022. It is manned from
9am to 5pm, Monday to Friday, by a number of experienced staff who can talk you through
any queries that you may have about the program. Please have your customer number to
hand before you phone – if you are not sure what it is, go to Help > About within the
program.

Alternatively, email us with your question and customer number to
support@farmplan.co.uk and we will respond as soon as possible. Our email box is checked
regularly throughout the working day.

Farmplan Website – www.farmplan.co.uk
Keep an eye on our website for news and answers to frequently asked questions. Click on
the ‘Online Support Centre’ button from the Home Page of the program to be taken directly
to the support area. You may be asked to enter your email address and Farmplan customer
number.

Farmplan Messages
We will also send you an electronic message via the program or email you if we have any
important news that we feel that you should know about urgently – for example new
updates to the program or changes in legislation, such as the VAT rate changes, so make
sure that our emails are not blocked as spam.
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Section 2: Installation Instructions
*Windows™ 7, Windows™ 8 and Windows™ 10



The option to download and install the latest version of the program can be
found under the Business & accounts heading in the Support area of the
Farmplan website (www.farmplan.co.uk/support). You will need your
customer number.





Follow the on-screen instructions to ‘Download Program Now’. The exact
procedure will vary according to the version of Windows and browser that
you use but just follow the instructions on the screen. You will download a
file called setup.exe, supplied by Reed Business Information (our parent
company), which should then be ‘Run’.





If Windows SmartScreen (a warning message) appears to block the
installation, click on More Information and then Run Anyway.





A black box will appear on your screen during the installation. Ignore it – it
will disappear when the installation is complete.





When the installation is complete you will see a confirmation message. Click
on ‘OK’. You can now use the program.



If you have any problems installing the program, please read the document available from
the Download screen by following the link called ‘Having Problems Installing?’ for more
details.
*Please note – Windows 7 will not be supported by Microsoft from January 2020. Future versions of Business
Manager will not install onto Windows 7 machines after this date. Please contact Farmplan to discuss
upgrading your PC if this is applicable.
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Section 3: Security and Licensing
When you first go into the program, it will say ‘Unregistered Copy’ at the top of the screen
and will be displaying the Farmplan Demonstration Data.

To licence your data via the Internet
Go to the File Menu – Licence and enter your details. For example: -

Click on the ‘Get Key’ button which will have been activated, to instruct the program to
look for your licence details using an internet link. Once the Activation Key has been filled
in, click on ‘Register’.
You will get a message saying Business Manager has been registered successfully – click
OK.
Click Close and it will take you back into the program.
IMPORTANT – Please keep the Web Access Code details safe and only give them to
authorised users. Any computer licensed with this unique combination of Customer Details
will be able to access your Farmplan licence details, messages and any Web backups that
you make.
For security reasons, if you lose this Web Access Code or you wish it to be changed for any
reason we will supply a replacement via the post only. We will require written authorisation
and will only send it to the person named on our records as your business’s main contact.
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To licence your data manually
If you do not have an internet connection you will need to enter the Activation Key
manually.
Enter your Customer Number and Name as above but enter the Activation Key instead of
the Web Access Code. If you have not been given the Activation Key details please contact
Farmplan on 01594 545022.

Licence Messages
You will receive messages when you start to approach your support contract renewal date,
which will be displayed when you go into the program. For example: -

To Renew your Licence
Once your support contract has been renewed, we will send you an electronic message to
tell you that your new Activation Key is ready. Go back to the option File > Licence and just
click on ‘Get Key’. If you do not have an internet access on this computer please contact us a
few days after payment and we will give you the new Activation Key to be entered
manually.
NB If your support contract has expired and you have not yet entered your updated
licence details, you will still be able to continue to use this version of the program
but you will not be able to load any future updates of Cash Manager until it has been
re-activated.
The ability to submit VAT via MTD and close VAT periods is only available to users with
a current support contract.
Please note that you are NOT eligible for telephone advice or data fixes after this date
if your old support contract has expired and has not been renewed.

SA 3.39

Page 8

Section 4: The Home Page
The Home Page provides you with easy navigation through the program. From the home
page you can click on any of the options from the side bar on the front screen and they will
take you to the relevant section.

Alternatively use the Tool Bar. Click on the arrows to scroll through the options available.

You can also access all options from the Menus at the top of the screen.
Before you start setting up your own data we recommend that you spend some time
investigating the options available from the Home Page using the Farmplan Demonstration
data to see how a complete set of data can be interrogated.
It is important that you take some time to plan the type of information that you wish to get
out of the program relating to your own business, as this will affect how you set up your
coding structure.
The exact options available through the Home Page will depend on the level of operation of
the program.
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Messaging
Farmplan can send electronic messages directly to you via the program. For example, we
will tell you when a new version of the program is available or that you have an updated
licence. In addition we pass on handy hints and tips, warn you of important news such as
VAT rate changes or remind you of local training seminars.
If there is a new outstanding message, you will see a reminder when you go into the
program and a summary of the newest message is displayed.

To read your messages, click on ‘Go to the Message Centre’ from the Home Page to go to
the list of messages:
To read a message, click on the subject to display
it on the right hand side of the screen.
Right-click on the message subject to bring up the
following menu:

Open (or double click) to display the message in a
new screen so that you can save it or email it.
Use the Flag to highlight important messages.
Delete – will remove the message from being
displayed on your computer.
Click on the column headings to sort messages.
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Cash Accounts

For the majority of farming businesses cashflow management is vital. All levels of the
program incorporate Cash Accounts, both for a 12 month cashflow and for monitoring
against a budget (cash trading) to show the projected cashflow that may be anticipated by
the end of the financial year. The figures on any of the cashflow reports are calculated from
the payment date of each entry.

Use the Select button to filter the cashflow for different
areas of the business e.g. by bank account

Use the ‘drill down’ button (?) to go from a
summary overview of the whole business
down to a standard layout and onto a
detailed cashflow i.e. each code shown
separately. Your own coding structure
should relate to what you would like to
see at each level. The bottom level of
analysis takes you to each individual entry.
SA 3.39

If the little ‘smiley face’ is yellow, the data
displayed is completely up to date. However
you can click on this button and change the
date back to one in the past so that the
data is only displayed up to this point. Once
you have built up more than one year of
data you can go back into previous financial
years.
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Farm Accounts
Cash Manager allows you to create enterprises with valuations in order to produce gross
and net margins for management analysis. These look at the margin of each enterprise over
its lifetime rather than just in one financial year. This is particularly important with arable
crops that may be sown on one year, incur costs and harvested in another financial year but
not sold until a 3rd financial year.

Either compare an
enterprise with a budget or
with another enterprise.

This report is displayed at the
summary level; use the drill
down button (?) to see the
analysis breakdown at standard
or detailed level.
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Enter the unit size of the
enterprise when you set it up so
that you get a meaningful
margin per unit.

The year suffix shown after the name of
the enterprise relates to the year that this
crop is harvested in.

Use the buttons at the bottom of
the screen to see the margin per
unit of production.
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Office Accounts

This set of reports will allow a detailed investigation of all areas of the accounts in order to
verify the figures entered and to carry out all the routine procedures required in the farm
office. This is the section where most everyday searching for information takes place.
Of particular importance is the Daybook which allows the inspection of all entries made to
the Cash Focus program regardless of type or date and the Items Inspector which lets you
interrogate your data by a wide range of filters.

Daybook
The list of entries may be filtered
according to certain criteria, e.g.
bank account.

Sort the list displayed by
double clicking on the column
headings e.g. transaction
number or date.

The transactions may be drilled into to see the original data entry screen
where they may be edited or cancelled according to normal data entry
rules.
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Items Inspector
The Items Inspector option is a powerful tool for identifying areas of interest within your
accounts. For example ‘How much have I spent on machinery repairs this year?’ or ‘What
have I bought from the supplier, Fred Bloggs, in the last 3 years?’ It allows items to be
filtered and grouped from all the entries made to the program and is the bottom level of
drill down of many other reports.

Click on the section that you wish to use to filter your data. This will take you to a secondary
screen. From here you select the exact level or combination of codes that you wish to
interrogate. Having made your selection you will see it listed on the right hand side of the
screen. That button will now have a against it to show that it has been used. Remove the
selection by clicking on the .
View Items – this report button will give you a list of the items that fall into the selection,
and can be analysed further by drilling down to the original entry.
Audit Report/Items Listing – these reports displays the same items sorted by heading code.
These reports have slightly different layouts – the best layout will depend on the reason for
the report and the filters made.
Items Analyser – to produce personalised reports in the form of a customised table.
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Section 5: Printing/Previewing Reports

Throughout the program you will see a Report button at the bottom of the screen that
allows you to produce a report – either on the screen or on paper.
This will normally take you to the Report Publisher Screen:
If you need to
change the printer
details use the
Setup button.

Use the Print button to send
the report to the selected
printer.

Any report can be exported in a variety of
formats such as Excel or PDF. The receiving
program will open automatically unless you
remove the tick from ‘Open/View’.

Alternatively you can email any
report – again a range of formats can
be used but if you are sending a
report to say your accountant to
read, the best format would be PDF.
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Section 6: Create your own Business
Take the option File > Select Business…



Click Create New



Complete the following screens, clicking on Next to move onto the next stage:

The Business Type will determine the
default codes used in the Autosetup
option.
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Year Start Date
It is important to enter your
Financial Year start date
correctly as this cannot be edited
once the data has been created.

The Farming Year is normally
the year the harvest takes
place in the first financial year
(e.g. a year start date of
01/12/18 would use 2019).
This year will appear as a
suffix to the current year’s
enterprises.

Bank Details
Enter the name of your main bank account here; you will get the chance to add more bank
accounts later.
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VAT Details
It is important to use the correct VAT
details when you submit your VAT
figures to HMRC but you can change
them in Setup – VAT later if you are not
sure at the minute.
Do you prepare a VAT return monthly or
quarterly? If it is quarterly you will need
to enter the completion date of the
current VAT period.

Password

When you have completed all the screens, click on Save to create your new Business.
SA 3.39
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Section 7: Set up Business Structure
Click on Setup along the top menu bar. You can set up the business structure by working
through each option on the list.

Set up Business Details
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Click on Business Details – Check and complete your Business information on this
screen and Save.
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Set up Enterprises by “Autosetup”
The Autosetup option is designed to allow you to quickly set up the initial framework of the
business by using pre-designed enterprise layouts and coding structures based on your
business type.
This makes setting up the business both quick and efficient. It is also very flexible; once the
basic skeleton of the system has been established, any area may be easily amended or
added to as required.
Click on the tabs at the top
to choose the Enterprise
Category.

When all enterprises have been
chosen then click Apply.

Click to highlight the chosen
Enterprise and click the single
arrow to add to the Use these
side of screen.

You can now fine tune and add to the
basic coding structure by going to
Setup Heading Codes and Setup
Enterprises.

If you want to keep things simple there are generic Arable and Livestock enterprises with
most of the codes that you will need. If you have a non-farming business use the enterprise
called General Template in the Commercial section to get a range of overhead and balance
sheet codes suitable for any business. (Delete or rename the General Template enterprise
in Setup – Enterprises; the codes will remain.)
SA 3.39
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Set up Enterprises without “Autosetup” i.e. from scratch
Click on Enterprises > Setup Enterprises

Check that you have the correct
Farming (harvest) Year displayed.
You should create an enterprise for
each year as needed.

To add a new Enterprise (or
Group) click on <New> at
the bottom of the existing
list on the right-hand side
of the screen.

Double click on the purple arrow
next to the relevant Enterprise
Category on the left-hand
column on the screen to display
the Enterprise Groups on the
right.

Enter the total size of
enterprise so that your
reports display the correct
margin per unit.

All enterprises may have valuations
associated with them. Double click
on the Enterprise Name on the lefthand side of the screen and enter
the stock name on the right-hand
side of the screen.

Double click on the green arrow
next to the Groups to display the
enterprises on the right.
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Set up Heading Codes
Heading codes are the individual cost centres of the business where information will be
posted to, and subsequently reported on. They are equivalent to the column headings in a
manual cashbook.
The tiered colour coded structure forms the basis of the accounts and will be reflected
throughout the reports:
Reports can be
selected at each level
BAND = SUMMARY
GROUP = STANDARD
HEADING CODE =
DETAILED

As with Enterprises, double click on
Band or Group on the left of the
screen to navigate round the
codes. They are displayed and can
be added/edited on the right hand
side of the screen.

Stores (optional) are used for
allocating something like fertiliser. It
can be put in stock when it is bought
and allocated to a specific enterprise
once an actual amount of product
has been used.

After allocating the code a name,
you will be asked to select an
appropriate Category from the list
– this will help the program
understand how this code is to be
used.
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Set up Heading Code & Enterprise Relationships
This screen links heading
codes to relevant enterprises
(e.g. Contracting Income to
the Contracting Enterprise).
This helps to streamline pick
lists in data entry, and
reduce possible mispostings.

Highlighting a heading code on the left
hand side will show which enterprises
are linked to it.

Click on a cross to change it
to a tick, if required.

Set up Searchcodes
Searchcodes are an additional means of identifying and reporting on specific areas of the
business, for example individual properties, specific projects, machinery costs (if the asset
register module is not present).
Codes can be grouped
together under Searchcode
Groups (e.g. Properties or
Vehicles) – see Setup
Searchcode Groups.

Searchcodes can also be marked as a Property so that they can be identified
in the Reports. Ticking this also allows you to add the Property Details on
the right hand side of the screen.
SA 3.39
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Set up Customers & Suppliers

NB – The minimum amount of information required is the customer or supplier name.
You may wish to group your suppliers and customers for reporting purposes – See Setup >
Supplier/Customer Groups.
Suppliers and customers can also be set up as you go along from the data entry screens.

Set up Banks
Make sure that you set up
each bank account that
you have, including the
petty cash tin.
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Set up VAT Details

You may need to specify that your VAT is calculated quarterly rather than monthly and the
end date of the current quarter. Unless you have specifically opted to use ‘Cash Accounting
for VAT’ with HMRC you should not change the calculation method – i.e. leave it as invoice
even though you will use cash analysis data entry.
It is important to get the VAT details correct before you make your first submission to HMRC
using Making Tax Digital (MTD) for VAT.

VAT Rates
This section should not normally need changing, as this will be set to the correct defaults rates
at time of supplying the software. (However they can be changed if VAT rates need editing in
the future).

R&C Details
You only need to enter the contact and bank details of HMRC if you will be printing cheques to
HMRC or paying them using electronic banking.
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MTD Settings
If you have not used Making Tax Digital (MTD) for VAT before, you must register with HMRC
for this service. Go to www.gov.uk/ and search for Use software to submit your VAT
Returns. Follow the instructions on the screen. After you have signed up, it may take up to
72 hours to receive the confirmation that you are ready to go.
Have you signed up and had
confirmation from HMRC that you
are ready to use MTD?

If you need to EXPORT VAT figures
from this business to another select
Via another dataset.

If all VAT figures are entered into
this business and will be submitted
to HMRC select Direct from this
business.

If you wish to IMPORT figures from
another business before submitting
the combined figures from this
business, select Yes to Combine
with other VAT figures.
This will affect the legal declaration
on the submission.

Once the options have been selected click Save, then click on the Connect to HMRC button.

You will then be taken through the HMRC connection process where you will be asked to
enter your User ID and Password. You should ‘Grant Authority’ for Farmplan Business
Manager to interact with HMRC.
This should be done on every machine that accesses this business where the user is
authorised to make VAT submissions.
Agents - you will need to create an Agent Services Account (ASA) with HMRC, if you do not
have one already, and link this to your clients. Go to www.gov.uk and search for Agents:
use software to submit VAT Returns.
SA 3.39
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Set up Opening Balances

It is not necessary to enter all your opening balances in order to get started but we would
recommend that you enter your bank balance as a minimum.
This should be the opening cashbook balance i.e. take the bank statement balance and add
back all unreconciled cheques and receipts to give the true bank balance.
If a bank account is overdrawn do not forget to put a –ve sign in front of the figure.
The VAT balance is the balance owed to or from HMRC at the beginning of the year.
Optional – you can also enter the opening balances of your enterprise valuations and stores
to produce accurate gross margins. We recommend that you ensure that your opening
balances agree exactly with your accountants figures as soon as they are available. This will
help your accountant reconcile the figures at the end of the year. Make sure that you
consult them each year to bring your balances in line with the final accounts. Adjustments
after the first year are normally done via journals or stock adjustments.

SA 3.39

Page 27

Section 8: Data Entry

Farmplan’s financial software is designed for easy data entry. Any data you input can be
viewed at a later date.
You only need to enter a piece of data once. The software can then use the information to
produce the calculations and reports you require.
The main pieces of data that people enter into the system are cash analysis transactions and
standing orders. This data forms the basis of all the reports that are produced by the
system.
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How to enter a Cash Analysis Payment or Receipt



Click on Cash Analysis
Select Cash Analysis Payment or Receipt
7

1

2

3
6

4
5

8

1. Cutomer/Supplier - Select the customer (or supplier) from the drop down list. Use the ?
to enter a new one.
2. Transaction Details - Enter the cheque details e.g. date paid, bank account, type (e.g.
cheque or direct credit/debit) and the total amount that will affect your bank account.
3. Coding - Allocate the items on the invoice by selecting a minimum of a Heading code and
Enterprise from the drop down lists. If the enterprise is not relevant use ‘General’.
Further analysis will be available if you use Searchcodes.
4. Description - Make sure that you enter a meaningful description so that you or your
accountant can identify this at a later date.
5. VAT - The program knows the default VAT rate from the Heading Code selected. If the
‘S’ (Standard) code is selected the program will automatically calculate the VAT at the
current rate. You can change this if required.
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6. Totals - You can enter as many different lines as you need. When the Total Amount at
the bottom of the screen equals the total you entered at the top, you have completed
this entry.
7. Entry Number - The program will generate an Entry Number (top left of the screen). We
recommend that you write this on the invoice so that you and your accountant can cross
reference it to the computer.
8. Data Entry Templates - This is a very useful tool available within the data entry options
that will speed up data entry and allow you to be consistent with your coding for similar
entries. For more details click on the Help button and follow the instructions.
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Entering VAT Payments & Receipts

Use this option to record payments to or from HMRC with regard to VAT – do not use the
normal cash analysis options.
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Repeating Transactions
Repeating transactions allow you to schedule and process regular entries to speed up data
entry and ensure consistency and accuracy of coding. The option is accessed from either
the Data Entry side bar or the Data Entry menu.

 Automatic Entries
‘Automatic’ entries are regular entries that occur at set intervals for the same
amount - for example standing orders or regular direct debits where the amount
stays the same. Once the instruction has been created they are implemented
automatically by processing them up to a specified date.

 Regular with Edit
'Regular with Edit' data entry templates create entries that occur at set intervals but
may have a varying amount. All information including any values can be edited at
the time of implementation to suit the exact detail on the transaction.

 On Demand
'On Demand' data entry templates allow you to create a default layout for a
transaction that can be applied to a supplier or customer as and when they are
needed. This will save time and ensure that the coding is consistent each time you
use it. All information including any values can be edited at the time of
implementation to suit the exact detail on the transaction.
NB – Both ‘Regular with Edit’ and ‘On Demand’ data entry templates are also available from
the normal cash analysis by using the 'Use' and 'Create' buttons at the bottom of the screen.

Filter the list by individual suppliers or
customers.

SA 3.39

Pick the type of repeating transaction that
you wish to use by clicking on the
appropriate tab.
The list of templates can be sorted by
clicking on any column heading.
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Create Repeating Entries
To add new repeating entry templates click on New at the bottom of the screen.
The template entry screen is similar to any other data entry screen with a few extra pieces
of information required. The exact options will depend on the type of template/payment
type etc.
Implemented – What kind of repeating entry is this?
Name - The template should be allocated a brief
description which will allow you to identify it on the
summary list.

Payment type – For an automatic
entry this will probably be standing
order or direct debit but you can pick
one of the other payment types, e.g.
electronic, if you wish.



Automatic (standing orders)



Regular with Edit (regular interval with
varying value)



On Demand (implemented as and when
needed)
Frequency – How often should
this transaction occur? This
will update the future ‘next
due’ dates automatically.

Next Due Date – When is the
next date that this transaction
should be created?

End Date – Transactions will
not be created after this date.
Leave blank if ‘on going’.

At the bottom of the screen you will see the date that the instruction was orignally created.

Templates can be permanently deleted if they are not required any more. Alternatively you
may wish to temporarily ‘finish’ them so that they can be rejuvenated or viewed in the
future.
Remember – this is just the repeating instruction. No transactions will be created until the
entries have been processed.
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Process ‘Automatic’ Entries
To implement any outstanding Automatic entries up to a particular date click on the Process
button at the bottom of the screen.
The ‘Process entries to’ date will
default to the end of the current
period but can be overwritten.

If you are happy that these
transactions should be created click on
‘Process Automatic entries’ at the
bottom of the screen.

Process ‘Regular with Edit’ entries
To implement any outstanding ‘Regular with Edit’ entries up to a particular date click on the
Process button at the bottom of the screen.

Each entry is processed one at at time by clicking on the ‘Process’
button at the end of the line which will take you to the normal data
entry screen for that particular transaction type where you can
complete or edit the details that are applicable to this instance of the
entry.
SA 3.39
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Process ‘On Demand’ entries
To use one of the templates just go to the Process button at the end of the line which will
take you to the normal data entry screen where you can edit the details to be used and
create a transaction.

On Demand data entry templates can also be selected or created from the options at the
bottom of the standard data entry screens.

NB – if you need to edit or view the details of any Repeating Transaction template
click on the ? at the left hand side of the grid.
Any specific transaction that you have created using the Repeating Transactions
option can be edited or viewed by going to the Daybook or Latest Entries on the
Home Page as normal.
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Use/Create Templates - from Data Entry screens
On Demand and Regular with Edit data entry templates can also be selected or created
from the options at the bottom of the standard data entry screens.

Use Templates
If a supplier (or customer) already has a template for this transaction type they will have a *
against their name. However you can also use the ‘Use’ button to pick the template of
another supplier, if required, by picking them from the drop down box at the top of the
screen.

NB if you select a template with a type of 'Regular with Edit' from this screen, it will be
treated as if it is 'on demand' - i.e. it is a one-off and the next due date will not be
implemented but will allow you have the same coding etc. If you wish to be reminded
about any 'regular with edit' transactions then you should use the full Repeating
Transactions option. Automatic templates are not available for selection in this screen.

Tip - Each column can be sorted by clicking on the column heading. For example if a
supplier has a large number of templates, you may wish to sort them by their name.

Create Templates
New templates can also be created from the standard entry screens.
Once you have entered the transaction that you will be storing as a template click on the
‘Create’ button.
You will be asked to give this template a name so that you can identify it again. If it the
same name as an existing one, perhaps you are just updating it, then it will confirm that you
want to overwrite it.
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Optional Information
The options that are to be saved with this template can then be customised:



Save default option information – selecting this box exactly replicates the
transaction.
 Transaction Reference - (if relevant). You may wish to retain the transaction
reference that you allocate to a direct debit or invoice.
 Description - allocated to each item; they may be edited or enlarged on when the
template is used.
 Quantity
 Amount & VAT
 Single item price - this will retain the price of one unit of quantity. You will then be
able to enter the quantity when you apply the template and the program will
calculate the total value of the entry.
If you do not want to save a particular option – perhaps the amount varies each time –
remove the tick in the appropriate box.

Implemented
Is this template ‘on demand’ – i.e. to be used as needed or will it occur at regular intervals?
If applicable you will be also be asked for
further details:

Save Template
Click on ‘Save Template’ to attach it to this transaction type/supplier (or customer)
combination.
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Entering Bank Reconciliation
The Bank Reconciliation option allows you to check all the entries made on the computer
against the bank statements for any account. This ensures that no entries are forgotten – for
example a standing order or direct debit that may have been overlooked. It also confirms
that all the entries have been entered accurately. Any amendments to existing entries may
be made directly from the Bank Reconciliation screen without having to exit to a different
part of the program.


Click on Bank Reconciliation (in the Data Entry section on the Home Page).



Select the Bank Account required.



Click Yes if you want to enter a new statement. Here you can record the statement
details i.e. Statement number, date, opening and closing balances.



Click OK to enter the Bank Reconciliation.



Transactions which have not been reconciled against any other statement will be
presented.

Double click on the column headings to sort them.

The transactions that appear on the
statement can be ticked off by
clicking on the crosses in the Rec?
column which turns the relevant
crosses to ticks.

Use the “?” button to
view/edit the entry.

When the Calculated Closing balance is the
same as the Closing balance at the top of the
screen and you have no Difference, your
statement balances.
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Closing VAT Period
The VAT due is calculated automatically from each transaction entered. This data is then
used by the program to generate your VAT Return records which can be submitted to HMRC
via Making Tax Digital.



Click on Close VAT in the Data Entry menu or from the Home Page.



The VAT Return will be calculated and printed when you click on Close VAT Period.
We would also recommend that you tick the boxes to produce a VAT Summary and
VAT Audit Detail report, but these can all be reproduced from the Report Library.



When you are happy that the details you are sending are correct, click on Close VAT
Period and send Direct to HMRC.



Tick the legal declaration of completeness and then Accept.



The details will be submitted to HMRC which will be confirmed on the screen.



Take a backup of your data. It is particularly important to keep a backup at the
beginning of each VAT period that you can return to during this period. However it is
very important that you do not restore data from a previously closed VAT period –
any amendments to figures must be made in the current open period.



An HMRC Receipt ID is received into the program to confirm that they have received
your VAT figures – see Inspectors – VAT – VAT Return Details. It is also printed onto
the VAT Return report.



Close VAT period manually – there may be occasions where you wish to close the
VAT period without making a submission – perhaps where you have already done it
on a different system (make sure the figures agree) or before you are mandated to
sign up for MTD. Select No to the question about being signed up with HMRC in
Setup – MTD settings.



Combine Figures – you may need to combine the VAT figures of more than one
business before you make a submission, either by exporting or importing figures.
Full details can be found in the program’s Help.
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Section 9: Back Up & Restore
For the security of your data it is very important that you back it up after every data entry
session. Each time you enter information it is saved within the computer. However it is
potentially vulnerable because if the computer was to break down, even if only through a
temporary power failure, that information may be irretrievably lost or damaged.
We particularly recommend that you take a backup immediately after submitting your VAT
submission. NB you should only return to an earlier backup to make amendments if it is in
the same open VAT period – do not change any figures once you have submitted your VAT
or they may no longer agree with HMRC’s.
The Home Page will display the last date/time a backup of this business was made.

To backup your data, take the option File > Backup.

Private Web Backups
This is the ability to back up your data to a remote web server across the internet. The web
server is maintained by our parent company, RBI, and provides a secure location for backups
away from your own office environment. The backup can be restored to any computer with
internet access regardless of its location, providing it has been registered with your licence
details and web access code – subject to your Farmplan licence agreement.
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A password provides additional security so that even if someone has your licence details,
they cannot restore your data without entering the password.
NB – Farmplan do not have access to the password. Therefore it is very important that you
keep a record of the password used.
You are provided with TEN free Private slots which are available providing your support
contract is up to date. More slots are available – for more details please contact the
Farmplan’s Software Support on 01594 545022.


On the left hand side of the screen check that the correct business is displayed.



Select the tab called Private Web Backups.



Highlight the slot that you wish to use by clicking on it (if there is more than one
available).



Password (optional) – Other users can only access your private backups if they are
using a computer with exactly the same licence details – i.e. other members of your
organisation who also have a valid licence. However, if you wish, you can also
password your backups so that no-one else can restore them without it. Put a tick in
the box ‘Use Password’ and enter the password in both boxes.



Click on Backup Now.



Enter notes to identify this backup in the future – for example ‘April accounts
complete’.



Confirm that you wish to continue.

Please Note – you are transferring data across the Internet so the time taken to make a
backup will depend on the size of your data and the speed of your Internet connection.
We would strongly recommend that you ‘minimise’ the size of your backups to help speed
up the process.
To do this, go to Tools –
Options - General and select
the option to Minimise
Backups.
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Local Backups
This allows you to make a copy of your data to be kept in your own office – either on your
computer or a removable device such as a memory stick.



On the left hand side of the screen check that the correct business is displayed.



On the right hand side of the screen browse to the location where you wish to make
the backup. To expand the tree view click on the +.



There will automatically be a folder called FbmBackup on your C:drive which should
have a sub-folder for each of your datasets.
To create more folders on your C:drive or memory stick, right click on the folder and
select the option to create a new sub-folder.



Highlight the folder that you wish to make the backup in and click on Backup Now.



Enter notes to help identify this backup in the future – for example ‘April accounts
complete’. A date and time will be automatically added.



Confirm that you wish to continue.

Backups to Removable Devices - While backups on the C: drive (the hard disk on your
computer) are useful for every day backups, they could get lost or damaged if something
happened to your machine. For that reason it is very important that you back up regularly
onto a removable device such as a memory stick which can be stored away from your
computer. Plug one into your computer before you go into the Backup option and it will
appear under a different letter on the right hand side – for example you may see something
like Removable Disk E:
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Rotation of Backups - Keep a minimum of 2 backups at different stages in time on different
sources. We suggest making sub-folders and use them to rotate your backups at different
stages in time.
NEVER just rely on one backup – for example a single memory stick, which could get lost or
broken.

Other Web Backups
This tab allows you to make Web backups which are available to Farmplan Support staff or
authorised third party consultants.
Support Slot - You are allocated ONE Support slot which can only be accessed by yourself or
a member of Farmplan staff.
If you contact us with a query, we may ask you to backup a copy of your data to this slot so
that we can restore it immediately for investigation – a much quicker and more
straightforward method than attaching it to an email.


On the left hand side of the screen check that the correct business is displayed.



Select the tab called Other Web Backups.



Highlight the support slot that you wish to use by clicking on it (if there is more than
one available).



Password (optional) – Other users can only access your support backups if they are
using a computer with exactly the same licence details – i.e. other members of your
organisation OR an employee of Farmplan. However, if you wish, you can also
password your backups so that no-one else can use them if they do not know that
password. Put a tick in the box ‘Use Password’ and enter the password in both
boxes.



Click on Backup Now.



Enter notes to help identify this backup in the future – for example ‘April accounts
complete’. If you have been asked to make this backup by a Farmplan member of
staff you may be given a reference number to quote.



If necessary, please email Farmplan (support@farmplan.co.uk) to confirm that the
backup is now available. Don’t forget to tell us the password if you have used one.

Third Party Slots
In addition we can supply you with a Third Party Slot – these can be used to supply a backup
of your data to an outside consultant/accountant who wishes to interrogate it using Cash
Manager.
For example your accountant may wish to have a copy of your data at the year end. His
computer will have a different licence so he will not normally be able to see your backups.
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You would make a backup to a 3rd party slot and provide your accountant/consultant with
your Customer Number and a 3rd Party Web Access Code – supplied by Farmplan. The 3rd
party user enters these when restoring your data. They will then be able to see all of your
3rd party slots. Again you can use passwords in order to provide additional security.

SA 3.39

Page 44

SA 3.39

Page 45

Farmplan Computer Systems
Alton House
Alton Road
Ross-on-Wye
Herefordshire
HR9 5BP
Phone: 01594 545011
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